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Power Bl Overview

Power Bl is a cloud-based analytics service that provides faster time to insight. It is used for visualizing,
exploring and extracting insights from data. Power Bl brings together data from diverse sources to deliver
rich, comprehensive views of business operations.

What that means is, with Power B, you can see all of your data through a single pane of glass, and create
an analytics environment in minutes to monitor data and share reports. Live dashboards and reports show
visualizations and KPIs from data that can reside both on-premises and in the cloud, providing a
consolidated view across your business, regardless of where your data lives.

Power Bl comes with two companion applications. The first one is Power Bl Desktop, a visual data
exploration and reporting tool for business analysts. The second one is a native, interactive mobile app for
business users that is available for iOS, Android and Windows mobile devices.

In addition, Power Bl offers a platform for developers to extend, embed and integrate Power Bl with custom
solutions. Interactive reports and visualizations can be embedded into applications and web sites and new
visualizations can be created for specific industries and use cases. A set of powerful REST APIs is available
to connect applications with visualizations and data in Power BI.

Power Bl Differentiators

Power Bl provides a unique set of features that empower everyone to benefit from direct access to data
and insights. Power Bl's distinctive set of features include:

e Pre-built dashboards and reports for popular SaaS solutions

e Live, real-time dashboards

e Secure, live connectivity to your data sources, on-premises and in the cloud

e Intuitive data exploration using natural language query functionality

e Auto insights into your datasets and reports

e Integrated with other Microsoft products and cloud services, including Azure Data Warehouse,
Azure Stream Analytics, Azure Machine Learning, Office 365, Cortana

This set of capabilities is designed to help organizations get the most out of their data, no matter where
that data lives — on-premise or in the cloud.

The main components of Power Bl and their capabilities are briefly introduced below.
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Power Bl Service

The Power Bl service offers a simple, intuitive experience for business users to interact with their data. You
can build rich, live dashboards that provide a single consolidated view of your business. A dashboard is a
set of visualizations, or charts, from one or more underlying reports, presented in an engaging way that
makes it easy to glean insights - no analytics expertise needed. Users can enjoy the benefits of up-to-date
data with real-time, automatic and scheduled refreshes. Dashboards can be shared with other people that
you work with, inside and outside of your organization.

Users can ask questions of their data in natural language, or use auto-generated insights to quickly analyze
a data set or report.

If you are not at the office, take your dashboards and reports with you on the Power Bl mobile app for your
device.

Power Bl connects to a variety of data sources, both in the cloud and on-premises. You can connect to
currently more than 60 popular Saa$S solutions, as well as your databases, regardless of where they live.

Power Bl also works well with files. Excel workbooks can be directly connected to, or may be used with
Power BI Desktop (more on Power Bl Desktop below). Like Excel files, or CSV files, Power Bl Desktop files
can be uploaded to the Power Bl service.

Power Bl Desktop

Power Bl Desktop - a desktop companion application to the Power Bl service - is a visual data exploration
and reporting tool geared toward Bl analysts. Power Bl Desktop centralizes, simplifies, and streamlines what



can otherwise be a scattered, disconnected, and arduous process of designing and creating business
intelligence repositories and reports.

Among other things, Power Bl Desktop enables you to acquire and prepare data using its built-in query
capability. Connect to the ever-expanding world of data, including your SAP Business Warehouse or SAP
HANA environments. Moreover, you can connect to your data sources in two different ways: you can import
a copy of the data into Power Bl Desktop, or you can connect directly to the data in its original source
repository, which is known as DirectQuery. Both connection .
modes are available for SAP Business Warehouse and SAP -gm
HANA.

Whether on-premise, in the cloud, big data, or file data, once
you connect to your data, Power Bl Desktop enables you to
transform, or shape, the data to meet your needs. With Power
Bl Desktop, shaping data involves defining and refining
queries. Every dataset imported into Power Bl Desktop is a
query that can be modified.

Power Bl Desktop also provides advanced analytics capabilities = - - . .
that help you structure complex data, create relationships, define SELEE
a variety of calculations, find correlations, highlight exceptions,
forecast business outcomes and more.

2.520n 293bn 1

Explore data using a freeform, drag-and-drop canvas, and
author reports with a broad range of data visualizations. When
you are ready for others to use your data models and reports,
publish directly to Power BI, and share through a unique, curated
content approach

Power Bl Platform

Power Bl is also a platform that allows developers to embed, extend, and integrate Power Bl with other
applications and environments.

Power BI allows you to embed stunning, fully interactive reports into your customer-facing apps without
the time and expense of building your own controls from the ground up. As a developer, you've built
applications, and those applications have their own users and distinct set of features. Those apps may also
have some built-in data elements like charts and reports that can now be powered by Microsoft Power BI
Embedded. Users don't need a Power Bl account to use your app. They can continue to sign in to your
application just like before, and view and interact with the Power Bl reporting experience without requiring
any additional licensing.

You can create customized visual experiences that meet your users’ needs and match your application’s
design. Microsoft's open-sourced, production-quality visualization code is available on GitHub and
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development and test tools are available to help the developer community build high quality custom visuals
for Power BI.

The REST APIs make it possible to integrate Power Bl with existing application workflows to deliver
immediate insights for professional and non-technical users. Applications can send data directly into Power
Bl, adding data exploration capabilities to an existing system. This allows for dynamic updates to dashboards
in real-time when the data changes, ensuring that users have the latest information.

On-Premises Data Gateway

With Power BI, data that needs to reside on-premises can

continue to reside on-premises. The on-premises data

gateway acts as a bridge, providing quick and secure data

transfer between on-premises data, including your SAP \|
Business Warehouse, and the Power Bl service. The data Marene & Monto

gateway also works across several Microsoft services, T Gipremises
including Power BI, Microsoft Flow, and PowerApps. /
w
Installing and configuring the data gateway can be done sas saL  SAPBW % @é

centrally, usually by an IT administrator for a department or
organization. IT can monitor and audit the usage of data
which is important for Bl governance.

With the data gateway, you can keep your dashboards, reports and datasets fresh, on an ad-hoc basis or a
scheduled interval. The gateway works with data that has been imported into Power BI, or directly connected
to in the source system, which is known as DirectQuery and is further outlined below.



SAP Business Warehouse

Introduction to SAP BW

SAP Business Warehouse (also known as SAP NetWeaver Business Warehouse, or simply SAP BW) is an
Enterprise Data Warehouse solution of SAP that provides key Bl capabilities for enterprise reporting, query,
and analysis, as well as business planning. SAP BW runs on standard relational databases (RDBMS), including
Microsoft SQL Server. As of release 7.4, SAP BW is optimized to run on SAP's HANA in-memory database.

SAP BW offers flexible ways of integrating data from various sources, both SAP and non-SAP systems, but
in particular from SAP’s transactional business systems: SAP ECC (ERP), CRM, SRM etc.

SAP BW is both rich and complex in functionality, this paper we will focus on the capabilities and key
concepts that are relevant for the use of Power Bl with SAP BW.

Data Objects in SAP BW

SAP BW comes with built-in tools for creating data models based on different data objects. It is helpful to
have a rudimentary understanding of how data is represented in SAP BW and the terminology. The main
data objects in SAP BW are briefly introduced here:

InfoProvider is the generic term for a Bl object into which data is loaded or which provides views of data.
InfoProviders can be queried with client tools, such as Business Explorer (or BEx, described below) and also
with Power Bl Desktop.

InfoProviders can be seen as uniform data providers from the viewpoint of a query definition. Their data
can therefore be analyzed in a uniform way.

InfoCube is a type of InfoProvider. An InfoCube describes, from an analysis point of view, a self-contained
dataset, for a business-orientated area, for example Purchasing. You can analyze an InfoCube directly as an
InfoProvider with analysis and reporting tools, including Power BI.

An InfoCube consists of a set of relational tables that are arranged according to an enhanced star schema.
This means there is a (large) fact table that contains the key figures for the InfoCube, as well as several
(smaller) dimension tables which surround it.

Key figure is an operational attribute, which indicates a numerical measure such as amount, weight,
quantity, etc.

Dimension is a grouping of related characteristics under a single generic term. For example, the Customer
dimension could be made up of the Customer Number, the Customer Group and the levels of the customer
hierarchy.

A Sales dimension could contain the characteristics Sales Person, Sales Group and Sales Office.

A Time dimension could have the characteristics Day (in the form YYYYMMDD), Week (in the form
YYYY.WW), Month (in the form YYYY.MM), Year (in the form YYYY) and Fiscal Period (in the form YYYY.PPP).



Characteristics refer to master data with their attributes and text descriptions, and in some cases
hierarchies. The characteristics of an InfoCube are stored in dimensions.

For example, the Customer dimension could have the characteristics Sold-to-party, Ship-to-party, and Payer.

The characteristic Sold-to-party could have the attributes Country, Region, City, Street and Industry. The text
description of the characteristic would be the Name of the Sold-to-party.

In MDX query terms, the attributes of characteristics are also referred to as properties.

InfoObjects is the generic term for all characteristics and key figures. All InfoObjects are maintained
independently of the InfoCube in SAP BW. InfoObjects are the smallest units of Bl. Using InfoObjects,
information can be stored and mapped in a structured form. This is required for constructing InfoProviders.
InfoObjects with attributes or texts can themselves be InfoProviders.

DataStore Object (DSO) serves as a storage location for consolidated and cleansed transaction data or
master data on a document (atomic) level. Unlike the multidimensional data in InfoCubes, the data in
DataStore objects is stored in transparent, flat database tables. The system does not create separate fact
tables or dimension tables for DSOs. Data in DSOs can be evaluated using a BEx query.

MultiProviders are a special type of InfoProvider that combine data from several InfoProviders. They are
then available for reporting. MultiProviders themselves do not contain any data, their data comes exclusively
from the InfoProviders upon which they are based on. MultiProviders can be based upon any combination
of InfoProviders, including InfoCubes, DataStore Objects, InfoObjects, or InfoSets.

InfoSets are a special type of InfoProvider which does not store data physically. InfoSets describe data
which is based on joining the tables of other InfoProviders like DataStore Objects, standard InfoCubes, or
InfoObjects with master data characteristics. InfoSets can be useful when you have to build a report
spanning two or more different data targets in SAP BW.

Composite Providers are a new data object in BW systems that run on HANA, e.g. SAP BW 7.5 or
BW4/HANA. A composite provider is based on a JOIN or UNION of other InfoProviders or Analytic Indexes.
Data in Composite Providers can be evaluated using a BEx query.

Reporting in SAP BW

SAP BW comes with a set of tools — the Business Explorer, or simply BEx tools - for enterprise reporting,
ad- hoc analysis, and dashboarding. With the BEx tools, business users have the ability to design, create,
analyze, and distribute data for analyses and decision-making support within their organization. In addition
to BEx, SAP offers several Bl reporting and analysis tools under the BusinessObjects (BO) brand that offer
pixel-perfect reporting, semantic models, browser-based user experiences, and dashboarding. The
BusinessObjects tools can work on top of BEx and can also be used with non-SAP data sources.



At the core of the BEx reporting and analysis functionality in SAP BW are Queries. Queries provide a flexible
platform for data analysis in SAP BW are important to understand for the Power Bl user. Queries act as the
bridge between SAP BW InfoProviders and the reporting / analysis client tools.

The BEx Query Designer is the main tool for designing queries and generating datasets from an
InfoProvider for analysis. With the Query Designer, the business user can limit the number of fields that are
displayed on a report. It also allows the user to define filters, variables, calculations, and more, that are
otherwise not available in the InfoProvider.

BEx Query Designer - Query: Purchasing Query - [u] X
Query Edit View Tools Help
DERS ERF| X NIRRT ER S EIEIE R
[InfoProvider | [Filter | |Properties
¢y Purchasing Data (Virtual) & ||y Characteristic Restrictions [Efp Defauit Values |Purchasmg Query (Query) -]
= &3 Key Figures - A Material - B Key Figures [‘WIB |%g-
H Jﬂ Delivery time in days (SAP DEM{ | & ﬁ Country H @ Country
- {§f Goods receipt quantity (SAP DE| - ﬁ Material Rows/Columns | Value Display ] Planning ]
/8 Invoice Receipt Quantity for Pos i fi8 Material group Extended |
.':;E Invoiced Amount for Posting Dal i M8 Vendor General IVariabLe Sequence 1 Display I
Zf8 Number of deliveries (SAP DEMY ? ﬁ Value Type -
i’_ﬂ Purch Order Value in Doc Cur.(: o fiH Veersion DHGI“II
/g8 Purchase order quartty (S4P D oo fF Plant [Purchasing Query &l
gl Val of Goods Received in Local - MKF Calendar Year Techascl Name
b | Wefghted total delivery time (SA! ﬁ Calendar Yaarernrrlh ‘ZD_PU_CW_WRT
-1 Dimensions o ﬁ Fiscal Year Vanant
.4 Country Key - JKF Base Unit InfoProvider
£ * Material Number i ‘ﬁ Cumrency/Unit [ZD_PU_CET
&) * Material Group | ﬁ Local curency
1 H Key Date
& * Purchasing Organization @ PurchOrderCumrency
-4 Vendor Number 0| &~
#)... 4 Version/Value Type u
. dfh Plant
B * Data Package
i) 3 Time
- Uit
< 5 SF Filter |B® Rows/Columns ‘
Last Changed
[ Messages Ouwiner: SCHULER
= E Messages for Cument Query Eastl E:I'hang?WT’éac—HBUSL"E; "
. . ate/Time: 3/14/2017 9:57:20 Al
& Local query check: Query "Purchasing Query'is comect Application: BEx Query Designer
Properties |¥2) Tasks |
o Bw2

Filters can be used to restrict the data retrieved by a query. Filters can be dynamic or static in nature. Values
entered as static filters cannot be overwritten by users at runtime while dynamic filters or variables can be
overwritten by the user when running a query.

Variables are query parameters that are defined in the Query Designer and are filled with values when a
query is executed. Variables are not specific to an InfoProvider, but rather on the InfoObject for which they
were created.

Calculations can be specified in the Query Designer on key figures, using formulas with built-in functions,
for example percentage functions.

For Power Bl Desktop to be able to connect to a BEx query in SAP BW, the property Allow External Access
to this Query must be set in the BEx Query Designer, as shown below.
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|Pmpenies
| ZD_PU_C01_Q0013 (Query) ~|

7= |-

Rows/Columns l Value Digplay ] Planning ]

General ] Wariable Sequence ] Display ]
Extended ]

Enterpnse ID
|DEFLIZM OP10X6ZIARGZA41VILE

Release for Bdemal Access
Allow External Access to this Queny

v By OLE DB for OLAP

Lightweight consumption
[~ By Easy Query

[~ By OData

Also included in the BEx tools is the BEx Analyzer. BEx Analyzer is an Add-On to Microsoft Excel and can
be installed as part of the SAP Frontend Tools (SAPGUI) for Bl. Data is embedded into Microsoft Excel
workbooks providing analyst users with drag-and-drop capabilities to drill down and filter the data using
SAP Bl OLAP functions. Excel functions and features can be used for additional analysis and capabilities.

Power Bl and SAP BW

SAP is a key enterprise Bl data source, and Power Bl connectivity to SAP systems is a desired capability for
enterprise customers who want to unlock insights from their most critical business systems.

Most of SAP customers have deployed SAP BW and they have gone through the effort of integrating their
transactional SAP data (from SAP ECC/ERP, CRM, SRM, or other business systems) into SAP BW. Enterprise
data in SAP BW has been cleansed, transformed and modeled for use in reporting, analytics and planning
applications. It only makes sense that customers want to utilize what they have already invested in and
connect Power Bl to their data in SAP BW.

Integration Architecture

From a technical point of view, the integration between Power Bl Desktop and SAP BW is based on the so-
called OLAP BAPIs (for Business Application Programming Interfaces).

The OLAP BAPIs are delivered with SAP BW and provide 3™-parties and developers with standardized
interfaces that enables them to access the data and metadata of SAP BW with their own front-end tools.

Applications of all types can be connected with a SAP BW server using these methods.
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The OLAP BAPIs are implemented in SAP BW as RFC-enabled function modules and are invoked by Power
Bl Desktop over SAP’s RFC protocol. This requires the NetWeaver RFC Library or SAP .NET Connector to be
installed on Power Bl Desktop machine (also see Prerequisites section below).

The OLAP BAPIs provide methods for browsing metadata and master data, as well as for passing MDX
statements for execution to the MDX Processor.

The OLAP Processor is responsible for retrieving, processing and formatting the data from the SAP BW
source objects, which are further described below.

3rd Party Clients SAP Business Explorer
mw
m
OLAP BAPIs o
5
MDX Processor o
()]
OLAP Processor g
InfoProvider & BEx Queries n
()
Data Objects Virtual Objects =
@
<
w
InfoCube DSO MultiProvider InfoSet

In contrast to 3" party clients like Power Bl Desktop, the SAP Business Explorer tools benefit from a more
direct and performant interface to the SAP BW OLAP Processor. The Business Intelligence Consumer
Services, or BICS interface, is the recommended way for the SAP BI tools to connect to the underlying data
sources. BICS is not available for 3™ party tools.

SAP BW Data Sources
The OLAP BAPIs provide Power Bl Desktop with access to BW InfoProviders and BEx Queries.

Typically, when a 3 party tool like Power Bl Desktop connects using the OLAP BAPIs, SAP BW first responds
with a list of catalogs available in the SAP BW system.
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There is one catalog with the technical name $INFOCUBE which contains all InfoProviders in the SAP BW
system. This catalog is shown as a node in the Navigator of Power Bl Desktop. By expanding this node in
the Navigator, the Power Bl user can select from the available InfoProviders in the SAP BW system.

The other catalogs represent InfoProviders for which at least one Query exists. By expanding one of these
nodes in the Navigator, the Power Bl user can select from the available queries that are associated with the
InfoProvider.

BEx Queries offer some advantages and additional functionality to create customized data sources to meet
end-user requirements. For example, you can parameterize queries with variables that can limit the data set
to what is important to the end user. Or, you can recalculate key figures using formulas.

Although BEx Queries have advantages as data sources (also see Performance Considerations section
below), customers do not need a Query for every report. Customers will need to weigh the cost of
developing and maintaining additional Queries against their reporting requirements.

SAP BW Connector versions:

Starting with the June 2018 release of Power Bl Desktop (and generally available with the October 2018
release), you can use the SAP BW connector with an implementation that has significant improvements in
performance and capabilities. This updated version of the SAP BW connector was developed by Microsoft
and is called Implementation 2.0. You can select either version 1 (v1) of the SAP BW Connector, or the
Implementation 2.0 SAP Connector.

Implementation 2.0 is based on SAP .NET Connector. This implementation provides all the capabilities of
Implementation 1.0 and more:

e Improved Performance

o Ability to retrieve several million rows of data, and fine tuning through the batch size option.

e Support for compressed mode. Especially beneficial for high-latency connections or large datasets.

e Improved detection of Date variables.

e Expose Date (ABAP type DATS) and Time (ABAP type TIMS) dimensions as dates and times respectively,
instead of text values. Exposed in the “Key” column.

e  Better exception handling: Errors that occur in SAP BAPI calls are now surfaced.

e Column folding in BasXml and BasXmlGzip modes.

e |f the generated MDX query retrieves 40 columns but the current selection only needs 10, this request will
be passed onto the server to retrieve a smaller dataset.

e  Support for currency, units and formatted values.

The following sections describe the installation of each version, in turn. You can choose one or the other
connector when connecting to SAP BW from Power Bl Desktop.

We suggest you use the Implementation 2.0 SAP Connector whenever possible.
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Installation of SAP BW Connector —
Implementation 1.0

Prerequisites

In order to use the SAP BW Connector Implementation 1.0, the following requirements must be met:

The NetWeaver library must be installed on your local machine. You can get the SAP NetWeaver library
from your SAP administrator, or directly from the SAP Software Download Center at
https://support.sap.com/swdc. The SAP NetWeaver library is usually included also in the SAP Client Tools
installation or SAPGUI installation.

Your SAP administrator can refer to SAP Note #1025361 for the download location of the most recent
NetWeaver library version. Ensure that the architecture for the SAP NetWeaver library (32-bit or 64-bit)
matches your Power Bl Desktop installation, then install all files included in the SAP NetWeaver RFC SDK
according to the SAP Note.

In Power Bl Desktop, you can select the File tab, then Help -> About to find out the specific version you
have installed.

Installation of SAP BW Connector —
Implementation 2.0

Prerequisites

Implementation 2.0 of the SAP Connector requires the SAP .NET Connector 3.0. You can download the
SAP .NET Connector 3.0 from SAP's website using the following link:

e SAP .NET Connector 3.0

Access to the download requires a valid S-user. Customers are encouraged to contact their SAP Basis
team to get the SAP .NET Connector 3.0.

The connector comes in 32-bit and 64-bit versions, and users must choose the version that matches their
Power Bl Desktop installation. At the time of this writing, the website lists two versions (for .NET 4.0
framework):

e SAP Connector for Microsoft .NET 3.0.20.0 for Windows 32-bit (x86) as zip file (6.896 KB), January
16,2018

e SAP Connector for Microsoft .NET 3.0.20.0 for Windows 64-bit (x64) as zip file (7.180 KB), January
16,2018
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When installing, in the Optional setup steps window, make sure you select the Install assemblies to GAC
option as shown in the following image.

-_ﬁ' SAP .Met Connector 3.0 for .NET 4.0 on x64 — >

Optional setup steps »

Installing assemblies to GALC allows different applications on the target computer ta share the
assemblies. Registering WM provider allows applications to publish ‘WHI objects provided by NET
Connector 3 so that the Wl objects can be quened or monitored using WM infrastructure.

O MNone
(®) Install assemblies to GAC

() Reaister WM| provider and install assemblies to GAC

Cancel < Back

Note: The first version of SAP BW implementation required Netweaver DLLs; if you're using
Implementation 2.0 of the SAP Connector, and not using the first version, the Netweaver DLLs are not
required.

Power Bl Desktop Installation Steps

The SAP BW Connector is included in the installation of Power Bl Desktop.

1. Download the latest version of Power Bl Desktop from http://powerbi.com and launch the Setup wizard
(.msi).

2. Follow the steps in the Setup wizard to complete the installation.
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Welcome to the Microsoft Power BI
[.lll] Desktop (x64) Setup Wizard
Power Bl

This wizard helps you change the way Microsoft Power BI
Desktop (x64) features are installed or helps you remove it
from your computer. To continue, click Next.

Back Next Cancel

Alternatively, you can install Power Bl Desktop from the Windows Store.

Getting started with the SAP BW Connector

Connection Types for SAP Business Warehouse

Power Bl Desktop offers two connection types for SAP Business Warehouse — Application Server
connections and Message Server connections. When you create a connection from Power Bl Desktop to
an SAP BW server, the logon parameters that you need to provide are very similar to when an SAP user is
logging on to SAP BW via the SAPGUI client tool.

With the connection type Application Server, Power Bl will always connect to the specified SAP BW server
(hostname or IP address) in your SAP landscape. This requires the server to have sufficient resources
available at any time to support the connection and process its workload, concurrently to all other
connections or work processes that may exist at the same time.

With the connection type Message Server, Power Bl will query a message server that has been configured in
your SAP system landscape. The message server will check which BW application server has the best load
statistics or the fewest users at that time, and Power Bl will make a connection to the most favorable server
based on that information. In addition to the message server, your SAP Administrator has configured a
Logon Group which comprises two or more application servers that will participate in logon load balancing.

SAP BW Application Server Connection

1. Launch Power Bl Desktop and close the splash screen that is shown initially.

2. From the Home tab, select Get Data -> More.
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3.

4.
5.

In the Get Data dialog, filter on Database connectors on the left, then select SAP Business
Warehouse Application Server from the list.

X
Get Data
Database
All SQL Server database A
File EI Access database
Database SQL Server Analysis Services database
Azure Oracle database

Online Services IEM DEB2 database

Other IBM Informix database (Beta)

IBM Netezza

MySQL database

PostgreSQL database

Sybase database

Teradata database

SAP HANA database

SAP Business Warehouse Application Server
SAP Business Warehouse Message Server

Amazon Redshift

<> Impala

Connect Cancel

Click on Connect.

In the SAP Business Warehouse Application Server connection dialog, enter the following
information:

Server: The application server (hostname or IP address) for the SAP BW instance

System number: The system number, or instance number of the SAP BW instance. This is typically a
two-digit number.

Client ID: The specific client in your SAP BW system that you want to connect to
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SAP Business Warehouse Application Server

Server
% = bwO.my-organization.com
System number
00
Client ID
800

Data Cannectivity mode (@

oK Cancel

Leave the Data Connectivity mode on the default Import selection. We will examine this setting in
more detail later in this document.

2.0 is the default implementation. Our suggestion is to use Implementation 2.0. Change it if
needed.

Click OK.

SAP BW Message Server Connection

Alternatively, you can create a connection to an SAP BW Message Server to take advantage of logon load
balancing in your SAP BW system landscape.

1.
2.

From the Home tab, select Get Data -> More.

Launch Power Bl Desktop and close the splash screen that is shown initially.

In the Get Data dialog, filter on Database connectors on the left, then select SAP Business
Warehouse Message Server from the list.
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4.
5.

Get Data
Database
All SQL Server database A
File El Access database
Database SQL Server Analysis Services database
Azure Oracle database

Online Services IBM DB2 database

Other IBM Informix database (Beta)

IBM Netezza

MySQL database

PostgreSQL database

Sybase database

Teradata database

SAP HANA database

SAP Business Warehouse Application Server
SAP Business Warehouse Message Server

Amazon Redshift

< Impala

Connect Cancel

Click on Connect.
In the SAP Business Warehouse Message Server connection dialog, enter the following information:

Server: The message server (hostname or IP address) configured in your SAP system landscape

System ID: The system ID of the message server. This is different from System Number and is
typically a three-character ID.

Client ID: The specific client in the message server that you want to connect to

Logon Group: The logon group of application servers that was configured by your SAP Administrator
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SAP Business Warehouse Message Server

- || msg0.my-arganization.com

ystem 1D
o0

o

6. Leave the Data Connectivity mode on the default Import selection. We will examine this setting in
more detail later in this document.

7. 2.0 is the default implementation. Our suggestion is to use Implementation 2.0. Change it if
needed.

8. Click OK.

Authentication Methods for SAP BW Connections

After you enter the logon parameters for your SAP BW application or message server, you will be prompted
for credentials to authenticate your connection.

Power Bl offers two authentication modes for SAP BW connections — user name / password authentication,
and Windows authentication (single sign-on). SAML authentication is not supported at the time of
publishing of this document.

User Name / Password Authentication

1. In the SAP Business Warehouse server dialog, select the Database tab on the left (default).

2. Enter your SAP BW User name and Password.
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SAP Business Warehouse server X
Windows bw0.my-organization.com/00/800

User name

SAPUser

Database

Password

Back Connect Cancel

3. Click Connect.

Windows Authentication and Single Sign-On

For Windows-based authentication and Single Sign-On functionality, your SAP BW server must be
configured for logon using SNC (Secure Network Communications). SNC is a mechanism provided by the
SAP system that enables application-level security on data exchanged between a client, such as Power B,
and the SAP application server. SNC works with different external security products and offers features that
the SAP system does not directly provide, including Single Sign-On.

In addition to your SAP BW server being configured for SNC logon, your SAP user account needs to be
configured with an SNC name (transaction SUO1 in your SAP system).

For more detailed information please see Secure Network Communication, and the chapter Single Sign-On
Configuration in this document.

Secure Login is a software solution by SAP that allows customers to benefit from the advantages of SNC
without having to set up a public-key infrastructure (PKI). Secure Login allows users to authenticate with
Windows Active Directory credentials.

Secure Login requires the installation of the Secure Login Client on your Power Bl Desktop machine. The
installation package is named SAPSetupSCL.EXE and can be obtained from the SAP Service Marketplace
(requires SAP customer credentials).

For further information please see Secure Login.
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In the SAP Business Warehouse server dialog, select the Windows tab on the left.
Select to either use your current Windows credentials or specify alternate Windows credentials.

Enter the SNC Partner Name. This is the configured SNC name in the SAP BW application server's
security token. You can retrieve the SNC name with transaction RZ11 (Profile Parameter Maintenance)
in SAPGUI and parameter name snc/identity/as.

For X.509 certificate security tokens, the format is:
p:<X.509 Distinguished Name>
Example (values are case sensitivel): p:CN=BWO0, OU=BI, 0=MyOrg, C=US

For Kerberos security tokens, the format is:
p:CN=<service_User_Principal_Name>

Example (values are case sensitivel): p:CN=SAPServiceBWO@BWSERVER.MYORG.COM

Select the SNC Library that your SAP BW environment has been configured for.

The option SNC_LIB or SNC_LIB_64 will check the corresponding environment variable on your
machine and use the DLL that is specified there.

The options NTLM and KERBEROS will expect the corresponding DLL to be in a folder that has been
specified in the PATH variable on your local machine. The libraries for 32bit systems are GSSNTLM.DLL
(for NTLM) and GSSKRB5.DLL (for Kerberos). The libraries for x64 systems are GX64NTLM.DLL (for
NTLM) and GX64KRB5.DLL (for Kerberos).

The option Custom allows for the use of a custom developed library.

Please validate the settings with your SAP Administrator.

_ SAP Business Warehouse server X

Windows bw0.my-organization.com/00/800

Use your Windows credentials to access SAP Business Warehouse.
Database
® Use my current credentials

Use alternate credentials

SNC Partner Name
p:CN=BWO01, OU=BI, O=MyOrg, C=US

SNC Library

® SNC_LIB_64 environment variable
NTLM (GSSNTLM.DLL) (insecure, not recommended)
KERBEROS (GSSKRB5.DLL)

Custom

Back Connect Cancel
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5. Click Connect.

Navigating the Query Objects in SAP BW

After you connect to your SAP BW instance, the Navigator dialog will be shown, with a list of available
catalogs in your SAP BW instance.

You will see one catalog folder with the name $INFOCUBE. This folder contains all InfoProviders in the SAP
BW system.

The other catalog folders represent InfoProviders in SAP BW for which at least one query exists.

o X
Navigator
jo

Display Options ~ &
4 =, bw2.theobald-software.com [23] S

> $INFOCUBE

p OCBR_ISO5

P OCBR_IS09

P 0CCA_009

p 0D_SD_001

p OMATERIAL

p Actual for NW Demo

» Actuals and Plan Multiprovider No items selected for preview

> Bank Analyzer ERP MultiProvider

> Customer

> FIGLO02S

> General Ledger (New): Transaction Figures

> General Ledger: Financial Statements

> General Ledger: Transaction Figures

[ Material/Week - Note: New Design of Inv...

[ Period-Specific Order/Material View

> Purchasing Data

> Purchasing Data

[ Purchasing Data (Virtual) v

Cancel

The Navigator will display a hierarchical tree of data objects from the connected SAP BW system. The types
of objects are listed here:

? Your SAP BW application server
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Catalog - either SINFOCUBE or an InfoProvider

InfoCube or a BEx Query

Key figure

Characteristic

g0 @ & e

Hierarchy

Navigator

Display Options ~
4 Purch J| Only selected items
ﬂ Enable data previews

+/| Technical names
¥yl Furcneseoraervae tveEsTT!

4 u Country
4

“aul r |

::'E PM_Country
¥ UL Level 02
& 1L Level 03
4 u Material
v T,_T Material Level 01
4 o= ] Properties
¥ [ Material group (Name)
4™ 1 purch. organization
v LT Purch. organization Level 01
4 ¥ [T Properties
¥ T Key

v :l Medium Name

¥ [T Purch. organization Level 01.Uni.

4 I,_: Vendor
v L:f Vendor Level 01

4 [ Properties

Characteristic Level

Property (Attribute)

Purchasing Qverview

Country.Level 02
EURCPE
EURCPE
EUROPE
EURCPE
EURCPE
EUROPE
EUROPE
EURCFE
EUROPE
EUROPE
EURCFE
EUROPE
EUROPE
EURCPE
EUROPE
EUROPE
EURCPE
EUROPE
EUROPE
EUROPE
EURCPE
EUROPE
EUROPE

<

Country.Level 03
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland
Deutschland

Deutschland

Material. Material Level 01

Casing Notebook Speedy | CN

Casing Notebook Speedy | CN

Casing Notebook Speedy | CN

Casing Notebook Speedy | CN
Motherboard Notebook Speedy | CN
Motherboard Notebook Speedy | CN
Matherboard Notebook Speedy | CN
Motherboard Notebook Speedy | CN
Processor Notebook Speedy | CN
Processor Notebook Speedy | CN
Processor Notebook Speedy | CN
Processor Notebook Speedy | CN
Casing Notebook Speedy Il CN
Casing Notebook Speedy Il CN
Casing Notebook Speedy Il CN
Casing Notebook Speedy Il CN
Motherboard Notebook Speedy I CN
Motherboard Notebook Speedy Il CN
Motherboard Notebook Speedy Il CN
Motherboard Notebook Speedy I CN
Processor Notebook Speedy Il CN
Processor Notebook Speedy Il CN
Processor Notebook Speedy |1 CN

Load

[z

Material.Material Level 01.M
Casings
Casings ~
Casings
Casings
Motherboards
Motherboards
Motherboards
Motherboards
Processors
Processors
Processors
Processors
Casings
Casings
Casings
Casings
Motherboards
Motherboards
Motherboards
Motherboards
Processors
Processors

Processors

Edit Cancel

Objects below an InfoCube or BEx Query node, such as the key figures, characteristics and properties, are
only shown in Import connectivity mode, not in DirectQuery mode (further described below).

You can select from different Display Options to view the available query objects in SAP BW:

Only selected items: This option limits the objects shown in the list to just the selected items. By default,
all query objects are displayed. This option is useful for a review of the objects that you included in your

query.
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Enable data previews (default behavior): This option allows you to control whether a preview of the data
should be displayed on the right-hand side in the Navigator. Disabling data previews reduces the amount
of server interaction and response time. Data preview is only available in Import connectivity mode.

Technical names: SAP BW supports the notion of technical names for query objects, as opposed to the
descriptive names that are shown by default. Technical names uniquely identify an object within SAP BW.
With the option selected, the technical names will appear next to the descriptive name of the object.

Characteristic Hierarchies

A characteristic will always have at least one characteristic level (Level 01), even when no hierarchy is defined
on the characteristic. The Characteristic Level 01 object contains all members for the characteristic as a flat
list of values.

Characteristics in SAP BW can have more than one hierarchy defined. For those characteristics, the user can
only select one hierarchy or the Level 01 object.

For characteristics with hierarchies, the properties selected for that characteristic will be included for each
selected level of the hierarchy.

0o x
Navigator
~ Purchasing Overview
Display Options = Preview downloaded on Sunday, November 26, 2017
L, Calendar Year/Month Country.Level 01 Country.Level 02 Country.Level 01.Name Country.Level 02.Name
4 W < Country [3] ~ REGION EUROPE REGION EUROPE
1 Country Level 01 REGION AMERICA REGION AMERICA
Fl PM_Country [3
¥ 17 Level 01
¥ 17 Level 02
L Level03
4 W T Properties [3]
£ Country Level 01.UniqgueName
==z Key
¥ £ Name
[ ) Material N 4 >
Load Edit Cancel

Measure Properties

When you pick a Measure in Import mode, you have an option to select the Units/Currency, Formatted
value, Format string. In the screenshot below, it is useful to get the Formatted value for COGS. This helps
us follows the same formatting standard across all the reports.

Note: Measure properties is not available in Direct Query mode.
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Navigator

P Show ~
Display Options ~
Apply Clear
4 Accounting Freight Cost - COGS [24] A
% gl cocs Accounting Freight Cost - COGS
¥l Gross Weight COGS COGS.Format string COGS.Formatted Value COGS.Unit of measure
ol Net Weight 16099490278 #,##0.00 16,099,490,277.91
4 ¥ ™ Measure Properties [3]

¥ T Format string

¥ T Formatted Value

¥ ™ Unit of measure

Flattening of Multi-Dimensional Data

Based on the selected objects and properties in the Navigator screen, Power Bl Desktop constructs an MDX
statement that is sent for execution to SAP BW. The MDX statement returns a flattened data set that can be
loaded into Power Bl or further manipulated using the Query Editor.

Power Bl uses a newer interface that is available in SAP BW version 7.01 or higher. The interface reduces
memory consumption and the result set is not restricted by the number of cells.

The flattened data set is aggregated in SAP BW at the level of the selected characteristics and properties.
Even with these improvements, the resulting dataset can become very large and time-consuming to process.

Performance recommendation: Only include the characteristics and properties that you ultimately need
in your Power Bl report or dashboard. Aim for higher levels of aggregation, e.g. do you need Material-level
details in your report, or is MaterialGroup-level enough? What hierarchy levels are required in Power BI? Try
to create smaller datasets, with higher levels of aggregation, or multiple smaller datasets, that can be
subsequently joined together in Power BI.

Query Parameters

Queries in BW can have dynamic filters defined which allow the end user to restrict the data set that is
returned by the query. In the BEx Query Designer, this type of dynamic filter can be defined with what is
called a Characteristic Restriction and assigning a Variable to that restriction. Variables on a query can be
required or optional and they are available to the user in the Power Bl Desktop Navigator.

When you select a BW query with characteristic restrictions in the Navigator, you will see the variables
displayed as Parameters above the data preview area.
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Navigator
P Show ~
Display Options ~ &
peyEp Material (optional) A
b Open Invoice - Vendor A values

4 Purchase Order, Goods Received and Invoice Rec...
¥ 1l Invoice Amount . .
Material Group (optional)
»
4 L, Calendar Year/Month values
4 17 Material 2]

v ‘L’ Material Level 01

—_ Calendar Month/Year (optional) v
P Properties [5] s -
411 Material Group [2] Apply —
‘La Material Group Level 01
b 157 Properties Purchase Order, Goods Received and Invoice Receipt... [%
44 L—' Purchasing Organization [2] Material.Material Level 01 Material.Material Level 01.Key Material.h
1n .
¥ 5, Purchasing Organization Level 01 Casing Notebook Speedy | CN CNO0S10 201
~
> B Properties Casing Notebook Speedy I CN CNOO0S10 201
A I-_). Vendor [2] Casing Notebook Speedy | CN CNO00S10 201
o, Casing Notebook Speedy | CN CNO0S10 201
~ . Vendor Level 01
Casing Notebook Speedy | CN CNO0S10 201
A¥ =
Properties (3] Casing Notebook Speedy | CN CNO0S10 201
L Key Casing Notebook Speedy | CN CN0O0S10 201
= Medium Name Casing Notebook Speedy | CN CNOO0S10 201
® 7 Vendor Level 01.UniqueName Casing Notebook Speedy | CN CNO0S10 201 Ny
. Casineg Notebook Soeedv | CN CNO0S10 201
[ Purchase Order, Goods Received and Invoice Rec... <
Load Edit Cancel

Using the Show selector, you can display all parameters that are defined on the query, or just the required
ones.

The query shown here has several optional parameters, including one for Material Group.

You can select one or more Material Groups to only return purchasing information for the selected values,
e.g. Casings, Motherboards and Processors. You can also type the values directly into the values field. For
variables with multiple entries, comma separated values are expected, in this example it would look like
[0D_MTLGROUP].[201], [0D_MTLGROUP].[202], [0D_MTLGROUP].[208].

The value # means unassigned, in the example any data record without a Material Group value assigned.
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Navigator
L Show ~
X
Display Options ~
Select Values @
[ Open Invoice - Vendor
4 Purchase Order, Goods Recei Select one or more values for "values"
¥ gl Invoice Amount ‘ |
¥ cal Year/Montt
[ L, Calendar Year/Month (Select All)
4% 1 Material 2] ¥ [0D_MTLGROUP].[201] p2], [0D_MTLGROUP].[208 --*
¥ 17 Material Level 01 ¥ [0D_MTLGROUP].[202]
v
> B B3 Properties [5] [0OD_MTLGROUP].[207]
. ) ¥ [0D_MTLGROUP].[208]
4| ¥, Material Group [2] [0D_MTLGROUPJ.[209] Apply Clear
1% Material Group Level 0 [0D_MTLGROUP].[#]
> [ 5] Properties d and Invoice Receipt...
488 | " Purchasing Organizatior jal.Material Level 01.Key Material.\
v L’ Purchasing Organizatid 10 201
A
b ® 5 Properties 10 201
4% 1Y Vendor [2] 1o 201
+ 2 10 201
¥ |5 Vendor Level 01
e 10 201
AV Properties [3] 10 201
¥ =1 Key 10 201
¥ T Medium Name oK Cancel 10 201
¥ ] Vendor Level 01.Uniq po 01
ST TYOTEDOUR JUETUv T TTY <rvood10 201

[ Purchase Order, Goods Received and Invoice Rec...

Load Edit Cancel

When parameter values are applied, the data shown in the Preview is filtered based on the parameter
selection.

Performance recommendation: Filters based on parameter values get processed in the SAP BW data
source, not in Power BI. This can have performance advantages when loading or refreshing SAP BW data
into Power B, for larger datasets. The time it takes to load data from SAP BW into Power Bl increases with
the size of the dataset, i.e. the number of columns and rows in the flattened result set. To reduce the number
of columns, only select the key figures, characteristics and properties in the Navigator that you eventually
want to see in your report or dashboard.

Similarly, to reduce the number of rows, use the available parameters on the query to narrow the dataset,
or to split up a larger dataset into multiple, smaller datasets that can be joined together in the Power BI
Desktop data model.

In many cases it may also be possible to work with the author of the BEx Query in SAP BW to clone and
modify an existing query and optimize it for performance by adding additional characteristic restrictions or
removing unnecessary characteristics.
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Loading SAP Data into Power Bl Desktop

Once you have selected the desired SAP data set in the Navigator, you can import the data into Power B
Desktop in two ways:

Select Load to bring the entire data set from SAP BW into the Power Bl Desktop data model. Power BI
Desktop will take you to the Report view where you can begin visualizing the data or making further
modifications using the Data or Relationships views.

Select Edit to launch the Query Editor, where you can perform additional data transformation and filtering
steps before the entire data set from SAP BW is brought into the Power Bl Desktop data model.

In the example above, a parameter was used to only bring back records with a Material Group of Casings,
Motherboards and Processors.

Transform  AddColumn  View  Help | Manage
< = Cube. Transform(#"e0_PU_Co1/8D_PU_CO1_Q0a13", v || Query Settings
1 Purchase Order, Goods... _ #" Material.Materisl Level 01 = | A% Materlal.Material Level 01.Material Level 01.UniqueMame - A% Material Material Level 01.Key = | A% Material.Material Level 01.Medium Name |~ | a% 4 PROPERTIES
1 Casing Notebook Speedy | CN (0D_MATERIAL] [CNDOS10] CNDOS10 ehook Speedy | CN Name
2 Casing Notebook Speedy | CN [0D_MATERIAL.[CNOOS10] CNOOS10 k Speedy | CN B
3 Casing Notebook Speedy | CN OD_MATERIAL]L[CNDOS10] CHDOS10 Cas ebook Speedy | CN All Properties
4 Casing Notebook Speedy | CN (OD_MATERIAL.[CNO0S10] CNODS10 Ca ehook Speedy | CN
5 Motherboard Notebook Speedy |CH [0D_MATERIAL] [CNDOS11] CNODS11 Motherboard Notebook Speedy | CN il L
6 Motherboard Notebook Speedy |CN  [0D_MATERIAL].[CNOOSL1] CNOOS11 Matherboard Notebook Speedy | CN S
7 Motherbosrd Notebook Speedy|CN | [0D_MATERIAL].[CNOOS11] CNODS11 Matherboard Notebook Speedy | CN Navigation
8  Motherboard Notebook Speedy | N [0D_MATERIAL] [CNO0S11] CNOOS11 Matherboard Notebook Speedy | CN 7 Added liems
9 Processor Notebook Speedy | CN (OD_MATERIAL].[CNO0S12] CNODS12 Pracessar Notebosk Spesdy | CN
10  Processor Notebaok Speedy | CN [0D_MATERIAL.[CNO0S12] CNOOS12 Processor Notebook Spesdy | CN
11 Processor Notebook Speedy | CN (0D_MATERIAL].[CNO0S12] CNOOS12 Processor Notebook Speedy | CN
12 Processor Notebook Speedy | CN (0D_MATERIALL[CNO0S12] CNOOS12 Processor Notebook Spesdy | CN
13 Casing Notebook Speedy Il CN [0D_MATERIAL.[CNO0S20] CNOOS20 Casing Natebook Speedy I CN
14 | Casing Notebook Speedy Il CN (0D_MATERIALL[CNO0S20] CNOOS20 Casing Natebook Speedy I CN
15 Casing Notebook Speedy Il CN [0D_MATERIAL.[CNO0S20] CNOOS20 Casing Natebook Speedy I CN
16 Casing Notebook Speedy Il CN (0D_MATERIALL[CNO0S20] CNOOS20 Casing Natebook Speedy I CN
17 Maotherboard Notebook Speedy Il N [0D_MATERIAL] [ENDOS21] CNDOS21 Maotherboard Notebook Speedy Il CN
18 Matherboard Notebook Speedy Il CN  [0D_MATERIAL] [CNDOS21] CNOOS21 Matherboard Notebook Speedy Il CN
19 Matherboard Netebook Speedy | CN (0D_MATERIAL] [CNDOS21] CNoDs21 Matherboard Notebook Speedy 1l CN
20 Motherboard Notebook Speedy Il CN [0D_MATERIAL] [CNDOS21] CNODS21 Matherboard Notebook Speedy I CN
21 Processor Notebook Speedy Il CN (OD_MATERIAL] [CNDOS22] CNODS22 Pracessor Notebook Speedy I CN
12 Pracessor Notebook Speedy Il CN OD_MATERIAL] [CNDOS22] CNDDS22 otebiook Speedy || CN
23 Processor Notebook Speedy Il N (OD_MATERIALL[CND0S22] cNoos22 Speedy I CH
24 Pracessor Notebook Speedy Il CN (OD_MATERIALL[CNDOS22] cNoOS22 . a Speedy Il CH
15 Casing Terminal PADO CN OD_MATERIAL] [CNDA00O] CNOL000 Casing Terminal P400 CN

In addition to importing data from SAP BW, you can also import data from a wide range of other data
sources into Power Bl Desktop, and combine them into a single report. For performance reasons, as outlined
above, you can also split a larger SAP BW data set into smaller datasets and join them together in Power BI
Desktop. Or, using the built-in connector for SAP HANA, you can combine bring together data from
different SAP sources. This opens many interesting scenarios for reporting and analytics on top of your SAP
data.

Additional topics for working with SAP BW data in the Power Bl Desktop Query Editor are described in the
following chapter.
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Advanced Topics

When you create a connection to an SAP Business Warehouse Application Server or an SAP Business
Warehouse Message Server you can optionally specify a Language Code, Execution mode, Batch size or
an MDX Statement.

Logon Language Code

Users can optionally specify a language code when establishing a connection to the SAP BW server.

SAP Business Warehouse Application Server

Server
#% - | bwO.my-organization.com
System number

00

Batch size
50000

MDX statement (optional)

Enable characteristic structures

oK Cancel

The expected value is a two-letter language code as defined in the SAP system. For a list of valid values,
click the Help icon (question mark) next to the Language Code field.

As a result, Power Bl Desktop will display the descriptive names of the data objects in SAP BW in the
specified language, including the field names for the selected objects.

Please note that not all languages listed may be configured in your SAP BW system or object descriptions
may not be translated in all languages.
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Navigator
jel Show ~
Display Options ~ &
play e - Material (optional) ~
b 0CCA_009 A values
b 0D_SD 001 Select one or mare values

b OMATERIAL .
4 Warengruppe (optional)

b Bank Analyzer ERP MultiProvider values
4 Einkaufsdaten [8] Select one or more values
4 Bestell-, Wareneingangs- und Rechnungseingan...
Monat/Kalenderjahr (optional) v

# yl RechBetr.Budat . e

4V [, t Einkaufsorganisation [2] Apply Clear
# 17 Einkaufsorganisation Stufe 01

4% [T Properties [3] Bestell-, Wareneingangs- und Rechnungseingangswerte
i Bezeichnung mittel Lieferant.Lieferant Stufe 01 Lieferant.Lieferant Stufe 01.Schlissel Lieferant.Lieferant Stufe 01.
¥ = Einkaufsorganisation Stufe 01.UniqueNa... PAQ Germany GmbH 1001 PAQ Germany GmbH
¥ T schlissel PAQ Germany GmbH 1001 PAQ Germany GmbH
> u Kalenderjahr/Monat PAQ Germany GmbH 1001 PAQ Germany GmbH
A Jotachi Deutschland AG 1050 Jotachi Deutschland AG
FEs [,_ Lieferant [2]
Jotachi Deutschland AG 1050 Jotachi Deutschland AG
¥ L Lieferant stufe 01 Jotachi Deutschland AG 1050 Jotachi Deutschland AG
4 Properties Technik und Systeme GmbH 1500 Technik und Systeme G
A u Material [2 Technik und Systeme GmbH 1500 Technik und Systeme G
% L" Material Stufe 01 Technik und Systeme GmbH 1500 Technik und Systeme Grryy
— . v Becker Components AG 3201 Becker Components AG
P Properties
Load Edit Cancel

If no language code is specified, the System Locale of the current user will be used and mapped to a valid
SAP language code.

MDX Statement

Instead of using the Navigator to browse through and select from available data objects in SAP BW, the
user who is familiar with the MDX query language can specify an MDX statement for direct execution in
SAP BW.

The statement for the example used throughout this document would look as shown below, based on the
technical names of the objects and properties in SAP BW.
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SAP Business Warehouse Application Server

Server
bw0.my-organization.com
System number
00
Client ID
800

Data Connectivity mode (i
® Import
DirectQuery

4 Advanced options
Language code
E ER @

MDX statement (optional)

SELECT {[@EFUZM@P16X72MBPOYVBYIMLB] . [EFUZMOP10X72MBPOYVBYISWY]} ON COLUMNS ,

NON EMPTY CROSSIOIN(CROSSIOIN([@D_MATERIAL].[LEVEL@1].MEMBERS,[@D_PUR_ORG].[LEVEL@1].MEMBERS) ,
[@D_VENDOR].[LEVEL@1] .MEMBERS)

DIMENSION PROPERTIES

[@D_MATERIAL].[20D_MATERIAL],

[eD_MATERIAL].[50D_MATERIAL],

[@D_PUR_ORG] . [2@D_PUR_ORG],

[@D_PUR_ORG] . [5@D_PUR_ORG],

[@D_VENDOR] . [ 26D_VENDOR],

|[eD_VENDOR] . [SOD_VENDOR] ON ROWS FROM [@D_PU_C@1/00_PU_C@1_00013]

oK Cancel

Power Bl Desktop will display a preview of the data that is returned by the MDX statement and the user
can select to load the data or further manipulate the data set in the Query Editor.

bw0.my-organization.com
[0D_MATERIAL].[LEVELO1].[S0D_MATERIAL] [0D_PUR_ORG].[LEVELO1].[20D_PUR_ORG] [0D_PUR_ORG].[LEVELO1].[50D_PUR_ORG]
Casing Notebook Speedy | CN 1512 Frankfurt
Casing Notebook Speedy | CN 1514 Berlin
Casing Notebook Speedy | CN 1516 Munich
Casing Notebook Speedy | CN 1518 Hamburg
Casing Notebook Speedy | CN 1552 London
Casing Notebook Speedy | CN 1552 London
Casing Notebook Speedy | CN 1554 Birmingham
Casing Notebook Speedy | CN 1592 Paris
Casing Notebook Speedy | CN 1612 New York
Casing Notebook Speedy | CN 1612 New York
Casing Notebook Speedy | CN 1614 San Francisco
Casing Notebook Speedy | CN 1662 Toronto
Casing Notebook Speedy | CN 1662 Toronto
Casing Notebook Speedy | CN 1664 Vancouver
Casing Notebook Speedy | CN 1664 Vancouver
<

Edit

[oD_
320
320:
320:
320
210(
350(
210(
330(
250(
415°
415
309(
351
3000
351

Cancel
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To validate and troubleshoot an MDX statement, SAP BW provides the transaction MDXTEST for SAPGUI
users. Further, the MDXTEST transaction can be a useful tool for analyzing server errors or performance
concerns as a result of processing that occurs within the SAP BW system.

For more detailed information on this transaction, please see MDX Test Environment.

= MDX e

V] ~«Heaee TR ew
MDX
[ (5 (GrExecute...  Pretty Printer “[DExecution Plan  #Generate MDX statement
€ Makardata |
Cube ~ n S‘Faterr!e_nt
0D PLICAL/D P (= e N SELECT )
&2 { [OEFUZMOP10X72MBPOYVBYIMLB] . [OEFUZMOP10X72MBPOYVBYISWHV] }
OLE DB for OLAP Metadata Technical Name  Object Inf... ON COLUMNS,
- 28 purchase Order, Goods 10D_PU_C01/0D_... 1 “0[{1 EMPTY Ce foin( (0D MATERTAL] . [LEVELO1] .M
. Al - Crossjoin Crossijoin | . V! -Members,
Ll (DA [FRIAT] (0D_PUR_ORG] . [LEVELO1] .Members 1,
‘%Hleramhles [0D_MATERIAL] [0D_VENDOR] . [LEVELO1] .Members )
* []Properties [0D_MATERIAL] DIMENSION PROPERTIES
- A Material Group [0D_MTLGROUP] [0D_MATERTAL] . [20D_MATERTAL], [OD_MATERTAL].[50D MATERTAL], [0D_PUR_ORG].
» & Hierarchies [0D_MTLGROUP] ON ROWS
B Properties JODSRITLGROUE] : FRL[)rt’)lD PU_C01/0D_PU_C01_00013]
- fPurchasing Organizatic[0D_PUR_ORG] :
» & Hierarchies [0D_PUR_ORG]
» [BlProperties [0D_PUR_ORG]
- Afvendor [0D_VENDOR]
» & Hierarchies [0D_VENDOR]
» [B] Properties [0D_VENDOR]
+ AfCalendar Year/Month [OCALMONTH]
- (Key Figures [Measures]
Invoice Amount [Measures].[OEF... 0D_INVRCVAL
a0 “r < » L i
IS Functinns. ] A. n12.. E
= Gtatemante |

MDXTEST can also be used to construct an MDX statement. The transaction screen includes panels on the
left that assist the user in browsing to a query object in SAP BW and generating an MDX statement.
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The transaction offers different execution modes/interfaces for the MDX statement. Select Flattening
(basXML) to mimick how Power Bl would execute the query in SAP BW. As briefly described earlier in this
document, this interface in SAP BW creates the row set dynamically using the selections of the MDX
statement. The resulting dynamic table that is returned to Power Bl Desktop has a very compact form that
reduces memory consumption.

[ Execute in Expert Mode
Interface
(Multidimensional (Flattening
(JCRM Internal ()Flattening (DataStream)
(Intern. API (®)Flattening (basXML)
(XML for Analysis [ ICompress Data

Row Restriction
(®)Specific Restriction
From
To
("Packaging

Pack. Size 0

The transaction will display the result set of the MDX statement as well as useful runtime metrics.

Result of MDX Statement
 Data Analysis
© Stats. Note: The column and row axis will be displayed
Total Run Time: 0.2350 sec [0D_MATERIAL]. [[0D_MATERIAL]. |[00_PUR_ORG]. [[0D_PUR ORG]. [[0D_VENDOR]. [[0D_VENDORL || e oxsomsrovvBvivia)
[LEVELOL]. [LEVELOL]. [LEVELOL]. [LEVELOL]. [LEVELO1]. [LEVELO1]. e it 7
# BAPT_MDDATASET SELECT DATA [200_MATERIAL] |[SOD_MATERIAL] |[200_PUR ORG] |[S0D_PUR ORG] |[20D_VENDOR] _|[S0D_VENDOR] ’
OLAP BAPL [Casing Notebook Becker
ﬁMDX T ecion lcnoos10 Cneoey TCN 1512 Frankfurt 3201 Companents AG_[535805.00
MDX Execution ( [Casing Notebook Becker
lcnoos10 1514 Berl 3201 316590.00
|40020]0.0000 sec |Read MxS Query Object [Speedy I CN i C AG
lcnoos10 g::‘gy”"‘““* 1516 Munich 3200 gf:;nenb G [7853439.00
= ASR_MDX_BXML_GET_INFO [Casing Notebook Becker
Event Runtime / Number Descrition lcnoos10 oy 1N 1518 Hamburg 3201 o G |158295.00
[40021{1 MDX QLAP Accesses lcHoos10 [Casing Notebook  , ooy London 2100 HiTech Corp 12628600.00
20000/0.0620 sec loLar Bart | [Speedy
40034[0.0630 sec [MDX baskML: Information on Rowset| lcNoos10 o NE |uss London 3500 SAPSOTA Corp  [512460.00
lcHoos10 [Casing Notebook  , 5, Birmingham 2100 HiTech Corp 1129440.00
= RSR_MDX_BXML_SET_BINDING [Speedy _
Event Runtime  Number Description [cNo0S 10 (Casing Notebook |, g, Paris 3300 (Générale 12131043.00
140000{0.0000 sec loLAP BAPT [Speedy L CN Flectronique .
40035/0.0000 sec [MDX baskML: Set Binding for Rowset] lcNo0s10 g:;"{?y“;mb““k 1612 New York 2500 Asia Technologies [691530.00
<SR DX BXHL GET INFG [cNooS 10 g:;"{?y“ﬁ:‘bmk 1612 New York 4151 Hatushiba Co. Ltd [5980800.00
- RsR
Event |Runtime / Number Description [cNOOS10 (Casing Notaback 5,4 ISan Francisco 4151 Hatushiba Co. Ltd [2589900.00
140000]0.0000 sec loLaP BAPT | [Speedy [ CNh -
|40034/0.0000 sec [MDX basxmL: on Rowset| IcN00S10 g:!‘c?vh:o;:l 2ok lie62 IToronto 3090 CompuMax Corp ~ |1119600.00
[Casing Notebook
- AR DX XML CET OATA lcnoos10 Spocy O 1662 Toronta 3510 ABC Technology ~ [1209600.00
Event [Runtime / Number|Description lcNoos10 g;ﬁv'\:ﬁ‘m“ 1664 Vancouver 3000 CompuMax Corp  [108000.00
40021[1 DX OLAP Accesses
40000]0.0150 sec loLaP BAPT | lcnoos10 g;;'ggv":‘ﬁ‘m“ 1664 Vancouver 3510 ABC Technology (931680000
|40036/0.0160 sec |MDX basxML: Retrieve Rawset Data Motherboard
Becker
lcnoos11 Potsbook Spesdy I 1512 Frankiurt 3201 o ents AG[1317909.00
Motherboard ok
lcnoos11 otebook Speecy I (1514 Berlin 3201 Companents G [[58298.00
Motherboard ockor
lcnoos1L Notebook Speedy I |1516 Munich 3201 [7019026.00
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Query Editor in Power Bl Desktop

With the Query Editor in Power Bl Desktop you can apply additional data transformations and filtering steps
before you bring the dataset from SAP BW into the Power Bl Desktop data model.

In the Query Settings panel on the right, the Applied Steps for query will be shown. To modify or review a
step, click the gear icon next to a step.

If you click on the gear icon next Added Items, you can review the selected data objects in SAP BW, or modify
the specified query parameters, for example. As described earlier, it is possible this way to filter a dataset
using a characteristic that is not included in the result set.

Help  Manage

Add Items

Select dimensions and measures to add to the query.

= Cube.Tr,

™ Purchase Order, Goods. . A% Material.Materisl Level 03 Name A% 4 PROPERTIES

1 Casing Notebook Speedy | CN Hace
> Casing Notebook Speedy | CN
Casing Notebook Speedy | CN

ebook Speedy | CN

4 APPLIED STEPS
ard Notebook Speed

6  Motherboard Notebook Speed Source

Navigati
Motherboard Notebook Speed avigation

» Added Items

Notebook Speed
book Speedy | C

book Speedy | C

Notebook Speedy | C

Notebook Speedy | C Select paran s for the query
ebook Speedy 11 CN

tebook Speedylich Material (optional) ~
values

14 Casing
5 Casing Notebook Speedy Il CN
16  Casing Notebook Speedy Il CN

1 Motherboard Notebook Speed
Material Group (optional)
values

8 Motherboard Notebook Speed

19 Motherboard Notebook Speed

20 Motherboard Notebook Speect
1 Processor Notebook Speedy II ¢
Calendar Month/Year (optional) v
22 Processor Natebook Speedy Il ¢ X
3 Processor Notebook Speedy I ¢
4 Processor Natebook Speedy I ¢
5 Casing Terminal P400 CN
asing Terminal P400 oK Cancel
6 Casing Terminal P400 CN

You can apply additional filters on the dataset, by selecting the drop-down menu for one of the columns.
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es [1) <

. #% Calendar Year/Month.Calendar Year/Month Level 01 - % Country.Level 01 ~ | A% Country.Level 02 ~ | A% Country.Level 03 ~| 12 Coststats currency ~| 1.2 Gross weight
"™ Sales and Distribution: 0... | 3| Sort Ascending Mot Assigned Country (s) Australia 4268607 .
Zl Sort Descending REGION EUROPE Germany 49328079
REGION EUROPE France 17969040
REGION EUROPE England 24809029
REGION AMERICA UsA 26032927
Remove Empty REGION AMERICA Canada 6451493
Text Filters * | REGION EUROPE Germany 28700489
Member Filters + | REGION EUROPE France 7233747
REGION EUROPE England 12050663
REGION AMERICA UsA 34116345
M (Select All) A REGION AMERICA Canada 10304981
M APR 2003 REGION EUROPE Germany 37991347
M APR 2004 REGION EUROPE France 11000854
M AUG 2003 REGION EUROPE England 13851025
B AUG 2004 REGION AMERICA usA 40193811
M DEC 2003 REGION AMERICA Canada 9643892
M DEC 2004 REGION EUROPE Germany 12026591
: :2 izgi REGION EUROPE France 9475899
B 1N 2003 REGION EUROPE England 18365679
¥ JAN 2004 REGION AMERICA UsSA 42272146
W JuL 2003 REGION AMERICA Canada 6156023
B UL 2004 REGION EUROPE Germany 16588484
¥ JUN 2003 REGION EUROPE France 12613687
B JUN 2004 REGION EUROPE England 22157663
¥ MAR 1030 REGION AMERICA UsA 25350099
¥ MAR 2003 W | REGION AMERICA Canada 11126587
# raananns REGION EUROPE Germany 14826079
oK ] REGION EUROPE France 25962516 v
REGINN FIIRAPF Enaland 1aRN2933

Another easy way to set a filter is to right-click on one of the values in the table, then select Member Filters
or Text Filters.

Queries [1] < . A% Calendar Year/Month.Calendar Year/Month Level 01 ~ | A% Country.Level 01 ~ | A% Country.Level 02 ~ | A% Country.Level 03 -

™ Sales and Distribution: ©... 1 MAR1030 Not Assigned Country (s) Australia
2 JAN 2003 REGION EUROPE Germany
3 JAN 2003 REGION EUROPE France
4 JAN 2003 REGION EUROPE England
5 JAN 2003 REGION AMERICA USA
& JAN 2003 REGION AMERICA Canada
7 FEB 2003 REGION EUROPE Germany
8 FEB 2003 REGION EUROPE France
9 FEB 2003 : Copy EUROPE England
10  FEB 2003 T Member Filters ! AMERICA USA
11 FEB 2003 :T Text Filters ' AMERICA Canada
12 MAR 2003 %2 Replace Values.. EUROPE Germany
13 MAR 2003 rill Down [ EUROPE France

Add as New Query

14  MAR 2003 I 1=~ )L ) E— EUROPE England
15 MAR 2003 REGION AMERICA USA
16  MAR 2003 REGION AMERICA Canada
17 APR 2003 REGION EUROPE Germany
18 APR 2003 REGION EUROPE France
19 APR 2003 REGION EUROPE England
20 APR 2003 REGION AMERICA USA
21 APR 2003 REGION AMERICA Canada
22 MAY 2003 REGION EUROPE Germany

For example, you could filter the dataset to only include records for Calendar Year/Month FEB 2003, or apply
a text filter to only include records where Calendar Year/Month contains 2003.

Please note that not every filter will get folded into the query against SAP BW. You can determine if a filter
is folded into the query by examining the icon in the top left corner of the data table, directly above the
number 7 of the first data record.
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If the icon is a cube, then the filter is applied in the query against the SAP BW system.

. |A% calendar Year/Month.Calendar Y

MAR 1030
JAN 2003
JAN 2003
JAN 2003

Vi woN =

JAN 2003

If the icon is a table, then the filter is not part of the query and only applied to the table.

. A% calendar Year/Month.Calendar Yi

8 APR 2003
9 APR 2003
10 APR 2003
11 APR 2003
12 MAY 2003
13 MAY 2003

Behind the Ul of the Query Editor, Power Bl generates code, based on the M formula language for data
mashup queries.

For additional information please see the Power Query M Reference.
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You can view the generated M code with the Advanced Editor option in the View menu.

W Advanced Editor
let
Source =
#"@D_PU_(
#"8D_PU_(
#"Added
{
ko]
in
#"Added
<
v No syntax

Purchase Order, Goods Received and Invoice Receipt Value o

SapBusinessWarehouse.Cubes("bw@.my-organization.com", "ee", "8ee", [ScaleMeasures=false]),
Ce1" = Source{[Name="@D_PU_ce1"]}[Data],

C01/0D_PU_CO1_Q8013" = #"oD_PU_C@1"{[Id="8D_PU_Cel/eD_PU_C@l_Qeo13"]}[Data],

Items" = Cube.Transform(#"eD_PU_C@l/eD_PU_Cel_Qee13",

{Cube.ApplyParameter, "[@D_MTLGR]", {{"[eD_MTLGROUP].[201]", "[@D_MTLGROUP].[202]", "[@D_MTLGROUP].[208]"}}},
{Cube.AddAndExpandDimensionColumn, "[@D_MATERIAL]", {"[@D_MATERIAL].[LEVELe1]"}, {"Material.Material Level @1"}},

{Table.AddColumn, "Material.Material Level @1.Material Level @1.UniqueName", each Cube.AttributeMemberProperty([Material.Material L

{Table.AddColumn, "Material.Material Level @l1.Key", each Cube.AttributeMemberProperty([Material.Material Level ©1], "[2@D MATERIAL]

{Table.AddColumn, "Material.Material Level @1.Medium Name", each Cube.AttributeMemberProperty([Material.Material Level @1], "[58D_M

{Table.AddColumn, “Material.Material Level @1.Material group (Key)", each Cube.AttributeMemberProperty([Material.Material Level @1]
{Table.AddColumn, "Material.Material Level @l.Material group (Name)", each Cube.AttributeMemberProperty([Material.Material Level @1
{Cube.AddAndExpandDimensionColumn, "[@D_PUR_ORG]", {"[@D_PUR_ORG].[LEVEL@1]"}, {"Purchasing Organization.Purchasing Organization Le

{Table.AddColumn, "Purchasing Organization.Purchasing Organization Level @1.Key", each Cube.AttributeMemberProperty([Purchasing Org

{Table.AddColumn, "Purchasing Organization.Purchasing Organization Level @1.Medium Name", each Cube.AttributeMemberProperty([Purcha
{Cube.AddandExpandDimensionColumn, "[@D_VENDOR]", {"[@D_VENDOR].[LEVEL®1]"}, {"Vendor.Vendor Level ©1"}},

{Table.AddColumn, "Vendor.Vendor Level ©1.Key", each Cube.AttributeMemberProperty([Vendor.Vendor Level @1], "[26D_VENDOR]")},
{Table.AddColumn, "vendor.vender Level @1.Medium Name", each Cube.AttributeMemberProperty([Vendor.vendor Level @1], "[5@D_VENDOR]")
{Cube.AddMeasureColumn, "Invoice Amount”, "[Measures].[@EFUZM@P1@X72MBPOYVBYISWV]"}

Items"

errors have been detected.

Done Cancel

To see a description for each function, or to test it, you can right-click on the existing SAP BW query in the

Queries panel and select Create Function. In the Formula Bar at the top, type = <function name>

Queries [1]

Jfr Func

< f\ = Cube.Transform
Cube.Transform

Applies the list cube functions, t ransforms, on the cube.

Enter Parameters

cube
transforms
Choose Column...
Invoke Clear

function (cube as table, t ransforms as list) as table
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Cube.Transform Applies the list of functions or transforms on the cube.
Cube.ApplyParameter  Applies the specified values for a parameter.

Cube.DisplayFolders Returns a nested tree of objects representing the display folder hierarchy of

the cube
Cube.Parameters Returns a table with the set of parameters that can be applied to the cube
Cube.Dimensions Returns a table with the set of dimensions for the cube
Cube.Measures Returns a table with the set of measures for the cube

Decimal Notation

User accounts in SAP BW have default settings for how decimal or date/time values are formatted when
displayed to the user in SAP GUI.

The default settings are maintained in the SAP system in the User Profile for an account, and the user can

view or change these settings in SAP GUI with the menu path System -> User Profile -> Own Data.

Maintain User Profile
4 Password

User SCHULER
Changed By 09/21/2016|07:05:36 Status

Add... < Defa... Parameters

Start menu

Logon Language

Decimal Notation 1,234,567.89 -

Date Format MM/DD/YYYY -
Time Format (12/24h) 12 Hour Format (Example: 12:05:10 PM) -

Power Bl Desktop queries the SAP system for the decimal notation of the connected user and it uses that
notation to format decimal values in the data from SAP BW.

To determine the decimal notation for the connected user, Power Bl calls the function module
BAPI_USER_GET_DETAIL in SAP BW. This function module returns a structure named DEFAULTS, with a
field named DCPFM that stores the decimal format notation.
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It is important that the user account in SAP BW has the necessary permissions to execute the function
module BAPI_USER_GET_DETAIL, otherwise the call from Power Bl Desktop will fail, typically with the error
message “You are not authorized to display users in group ..."

Import vs. Direct Query

With Power BI, you can connect to a wide variety of data sources, including online services, databases,
different file formats, and others. You can connect to these data sources in two different ways: you can
either import data into Power Bl, or you can connect directly to data in the source repository, which is
known as DirectQuery. When you connect to an SAP BW system, you can also choose between the two
connectivity modes. For a complete list of sources that support DirectQuery, refer to the article Data Sources
supported by DirectQuery.

The main differences between the two connectivity modes are outlined here, as well as guidelines and
limitations, as they relate to SAP BW connections. For additional information please also take a look at Using
DirectQuery in Power BI.

Import Connections

When you connect to a data source with Power Bl Desktop, the Navigator will allow you to select a set of
tables (for relational sources) or a set of source objects (for multidimensional sources).

For SAP BW connections, you can select the objects you want to include in your query from the tree
displayed. You can select an InfoProvider or BEx query for an InfoProvider, expand its key figures and
dimensions and select specific key figures, characteristics, attributes (properties) or hierarchies to be
included in your query.

The selection defines a query that will return a flattened data set consisting of columns and rows. The
selected characteristics levels, properties and key figures will be represented in the data set as columns. The
key figures are aggregated according to the selected characteristics and their levels. A preview of the data
is displayed in the Navigator. You can edit these queries in Power Bl Desktop prior to loading the data, for
example to apply filters, or aggregate the data, or join different tables.

When the data defined by the queries is loaded, it will be imported into the Power Bl in-memory cache.

As you start creating your visuals in Power Bl Desktop, the imported data in the cache will be queried. The
querying of cached data is very fast and changes to the visuals will be reflected immediately.

However, the user should take care when building visuals that further aggregate the data, when dealing
with non-additive measures. For example, if the query imported each Sales Office, and the Growth % for
each one, then if the user built a visual that will Sum the Growth % values across all Sales Offices, that
aggregation will be performed locally, over the cached data. The result would not be the same as requesting
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the overall Growth % from SAP BW, and is probably not what is intended. To avoid such accidental
aggregations, it is useful to set the Default Summarization for such columns to Do not summarize.

If the data in the underlying source changes, it will not be reflected in your visuals. It will be necessary to
do a Refresh, which will re-import the data from the underlying source into the Power Bl cache.

When you publish a report (.pbix file) to the Power Bl service, a dataset is created and uploaded to the
Power Bl server. The imported data in the cache is included with that dataset. While you work with a report
in the Power Bl service, the uploaded data is queried, providing a fast response time and interactivity. You
can set up a scheduled refresh of the dataset, or re-import the data manually. For on-premise SAP BW data
sources, it is necessary to configure an on-premises data gateway (further described in the following
chapter).

DirectQuery Connections

The navigation experience is slightly different when connecting to an SAP BW source in DirectQuery mode.
The Navigator will still display a list of available InfoProviders and BEx queries in SAP BW, however no Power
Bl query is defined in the process. You will simply select the source object itself, i.e. the InfoProvider or BEx
query, and see the field list with the characteristics and key figures once you connect.

For BW queries with variables, you will be able to enter or select values as parameters of the query. Select
the Apply button, to include the specified parameters in the query.

Instead of a data preview, the metadata of the selected InfoCube or BEx Query is displayed.

Once you click on the Load button in the Navigator, no data will be imported.
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Navigator
jol Show ~
Display Options ~ &
pay=p [ Material (optional) A
> General Ledger (New): Transaction Figures A values
> General Ledger: Financial Statements
> General Ledger: Transaction Figures . .
9 9 Material Group (optional)
b Material/Week - Note: New Design of Inventory M... values
3 Period-Specific Order/Material View [OD_MTLGROUP].[201], [0D_MTLGROUP].[202], [OD_MTLGROUPL.[208 ---
4 Purchasing Data [8]
Calendar Month/Year (optional) v
0D_PU_CO1_QO013KE . .
Average Delivery Time - Vendor Apply Clear
Open Invoice - Vendor
Purchase Order, Goods Received and Invoice Rec... Purchase Order, Goods Received and Invoice Receipt.. [
Purchase Order, Goods Received and Invoice Rec... d e Description
Purchasing Overview [0D_MATERIAL] Material
Table 6 [0D_MTLGROUP] Material Group
Table 7 [0D_PUR_ORG] Purchasing Organization
. [0D_VENDOR] Vendor
P Purchasing Data
[OCALMONTH] Calendar Year/Month
b Purchasing Data (Virtual) [Measures].[DEFUZMOP10X72MBPOYVBYISW\ nvoice Amount
> Sales: Overview
)3 SAP Demo Sales and Distribution: Overview
> SAP DemoCube
) v
3 Service Level < >
Load Edit Cancel

You can make changes to the values for the BW query variables with the Edit Queries command on the
Power Bl Desktop ribbon.

Home View Modeling Help

Cut
~
Copy ~
Paste ) . Get Recent  Enter Edit Refresh
Format Painter Data ™ Sourcas™ Data Queries™
Clipboard Edit Queries

. Data source settings
Edit Parameters

Edit Variables

As you start creating your visuals in Power Bl Desktop, the underlying data source in SAP BW will be queried
to retrieve the required data. The time it takes to update a visual will depend on the performance of the
underlying SAP BW system.
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Any changes in the underlying data will not be immediately reflected in your visuals. It will still be necessary
to do a Refresh, which will re-run the queries for each visual against the underlying data source.

When you publish a report to the Power Bl service, it will again result in the creation of a dataset in the
Power Bl service, just as for an import connection. However, no data is included with that dataset.

While you work with a report in the Power Bl service, the underlying data source is queried again to retrieve
the necessary data. For DirectQuery connections to your SAP BW and SAP HANA systems, it is required to
have an on-premises data gateway installed and the data source registered with the gateway (further
described in the following chapter).

For BW queries with variables, end users will have the ability to edit parameters of the query.
Note: at the time of writing this document this feature is in preview mode. For the end user to edit parameters, the
dataset needs to be published to a premium workspace, in Direct query mode and SSO needs to be enabled.

General Recommendations

You should import data to Power Bl whenever possible. This takes advantage of the high-performance
query engine of Power Bl and provides a highly interactive and fully featured experience over your data.

However, DirectQuery provides the following advantages when connecting to SAP BW:

e Provides the ability to access SAP BW data using SSO, to ensure that security defined in the underlying
SAP BW source is always applied. When accessing SAP BW using SSO, the user's data access
permissions in SAP will apply, which may produce different results for different users. Data that a user
is not authorized to view will be trimmed by SAP BW.

e Ensures that the latest data can easily be seen, even if it is changing frequently in the underlying SAP
BW source.

e Ensures that complex measures can easily be handled, where the source SAP BW is always queried for
the aggregate data, with no risk of unintended and misleading aggregates over imported caches of the
data.

e Avoids caches of data being extracted and published, that might violate data sovereignty or security
policies that apply.

Using DirectQuery is generally only feasible when the underlying data source can provide interactive queries
for the typical aggregate query within seconds and is able to handle the query load that will be generated.
Additionally, the list of limitations that accompany use of DirectQuery should be considered, to ensure your
goals can still be met.

If you are working with either very large datasets or encounter slow SAP BW query response time in
DirectQuery mode, Power Bl provides options in the report to send fewer queries, which makes it easier to
interact with the report. To access these options in Power Bl Desktop, go to File > Options and settings >
Options, and select Query reduction.
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Options

GLOBAL Reduce number of queries sent by

Data Load Disabling cross highlighting/filtering by default

Power Query Editor Slicers

DirectQuery # Instantly apply slicer changes

R scripting Add an Apply button to each slicer to apply changes when you're ready
Python scripting Filters

Security # Instantly apply basic filter changes

Privacy Add Apply buttons to all basic filters to apply changes when you're ready

Regional Settings
Updates

Usage Data
Diagnostics
Preview features
Auto recovery

Report settings

CURRENT FILE

Data Load
Regional Settings
Privacy

Auto recovery

DirectQuery

. oK Cancel
Query reduction

Report settings

You can disable cross-highlighting throughout your entire report which will reduce the number of queries
sent to SAP BW. You can also add an Apply button to slicers and filter selections. You can make as many
slicer and filter selections as you want, but no queries will be sent to SAP BW until you select the Apply
button. Your selections will then be used to filter all your data.

These changes will apply to your report while you interact with it in Power Bl Desktop as well as when your
users consume the report in the Power Bl service.

In the Power BI service, the query cache for Direct Query connections is updated on a periodic basis by
querying the data source. By default, this happens every hour, but it can be configured to a different interval
in dataset settings. This is further described in the On-Premises Data Gateway chapter of this document.

In addition, many of the general best practices described in Using DirectQuery in Power Bl apply equally
when using DirectQuery over SAP BW. Additional details specific to SAP BW are described in
https://docs.microsoft.com/en-us/power-bi/desktop-directquery-sap-bw
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Data Refresh with the On-Premises Gateway

Once you have your visuals and reports published to the Power Bl service, you can keep your data fresh
by connecting to your BW data sources with the on-premises data gateway. This is an important
consideration for SAP customers with on-premise installations of BW.

The on-premises data gateway from Microsoft acts as a bridge, providing quick and secure data transfer
between the on-premises SAP BW system(s) and Power Bl. The on-premises data gateway also works with
Microsoft Flow, Logic Apps, and PowerApps services.

The data gateway supports both DirectQuery connections to your SAP BW systems, as well as Import
connections, which can be refreshed manually or scheduled.

For general information about the on-premises data gateway, please see https://docs.microsoft.com/en-
us/power-bi/service-gateway-onprem

Installation of the Gateway

The on-premises data gateway supports two installation modes:

On-premises data gateway — allows multiple users to connect to multiple on-premises data sources, and
can be used by Power Bl, PowerApps, Flow and Azure Logic apps, all with a single gateway installation.
Both DirectQuery and scheduled refresh are supported.

This is the recommended mode for enterprise application sources such as SAP BW.

On-premises data gateway (personal mode) — allows one user to connect to sources, and can't be
shared with others. Can only be used with Power Bl. Only scheduled refresh is supported.

For detailed requirements and installation steps for the on-premises data gateway, please go see the
download page.

On-premises Data Gateway App
The on-premises data gateway will install an app on your on-premise machine which you can launch to

find status information, restart the gateway, access and set the level for diagnostics information and
configure secure communication.
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CI’} On-premises data gateway

¥ The gateway My Data Gateway is online and ready to

Service Settings be used.

Di . Gateway version number: 14.16.6480.1
iagnostics

Network Help us improve the on-premises data gateway by sending usage information
to Microsoft.

Read the privacy statement online

Logic Apps, Azure Analysis Services Create a gateway in Azure
West US

PowerApps, Microsoft Flow

Default environment ¥) Ready

Power Bl

Default environment ¥ Ready
Close

Managing your SAP BW Data Source in Power Bl

Once you have installed the on-premises data gateway, you can manage it in the Power Bl service from
the Settings -> Manage gateways menu.

@® nNewlookon [ £33

Manage personal storage

Create content pack
= View content pack

Admin portal

Manage gateways

Settings

ﬁq Manage embed codes




In the Gateway Settings, you can provide basic information about your gateway, including Name,
Description or Contact Information.

H PowerBl Myw

(A Home g o
sateway Cluster Se Adrninist
S & GATEWAY CLUSTERS
@© Recent > ) 4 to go.
- MacPCGateway
& apps

' Shared with me -
Test all connections

D workspaces >

B My workspace

Leam more

nis cluster. Leam mers

On the Administrators tab for the gateway, you can add, or remove, users or security groups that can
administer the gateway.

To add your SAP BW data source(s) that you want to access with the gateway, select Add Data Source.

Specify a Source Name, select the Source Type as SAP Business Warehouse Server and enter the
connection parameters for your server.

1 powerBI My

ADD D&

@ Home Data Source Setting e

GATEWAY CLUSTERS
e (il ’ ? NP Gatenay Data Source Nae
© Recent > MacPCGateway
B apps

Test all connections
A Shared with me
@ Workspaces > .
b ganization.com

B My vorkspace v

>Advanced settings

Add Discard

47



Note that the Username and Password represent an SAP logon account which has been configured with
certain privileges in SAP BW. The data set being retrieved from SAP BW will depend on the privileges for
this account in SAP BW.

Under Advanced settings, you can configure the privacy level for your data source. This controls how
data can be mashed up. This setting is only used for scheduled refresh, it does not apply to DirectQuery.

You can also enable SSO via Kerberos for Direct Queries under Advanced settings.

For additional information on setting privacy levels in Power Bl Desktop, please see
https://docs.microsoft.com/en-us/power-bi/desktop-privacy-levels

vAdvanced settings

Use SSO via Kerberos for DirectQuery queries

This will only be applied for DirectQuery queries. Import will use the Username and Password specified in the data source
details Learn more

Privacy Level setting for this data source

Organizational

After you Add the data source settings, you can use this data source for scheduled refresh or DirectQuery
against your on-premise SAP BW system.

You will see a confirmation message if your connection was successful.

Data Source Settings  Users

Connection Successful

(D Next Step: Go to the Users tab above and add users to this Data Source

On the Users tab for your SAP BW data source, you can add, or remove, users, or security groups, that can
use this data source.

Note that the users list only controls who is allowed to publish reports that use the BW data source. The
report owners can create dashboards, or content packs, and share those with other users.
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Data Source Settings ~ Users

People who can publish reports that use this data source

Enter email addresses Add

O Christoph Schuler

Using your SAP BW Data Source in Power BI

After you have created the SAP BW data source, it will be available to use with both DirectQuery and
Import (manual or scheduled refresh) connections.

Note that the SAP BW server, instance number, and client number have to match between the
connection in Power Bl Desktop and the data source connection in the on-premises data gateway.

The link between your dataset and the data source in the gateway is based on these three attributes of
the SAP BW connection.

Import Connections: Scheduled Refresh

If you are listed in the Users tab of the data source configured in the gateway, and the SAP BW server
name, instance and client number match, you will see the Gateway connection and Scheduled refresh
as an option for your dataset.

Go to your Workspace Settings and switch to the Datasets tab. Select the dataset that you want to
schedule a refresh for.
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This dataset has been configured by Nikil@obvience com.

Refresh history

4 Gateway connection

To use a data ake sure the co
gatew please selec

deled in Manage Gateways. If you're using an On-premises data
v click apply

Use a data gateway

Gateway Department Contact information Status Actions
NP Gateway Nikil@obvience.com F 8

A\ You have no personal gateways installed. Learn more

Install now

»
»Parameters

»Query Caching
»Scheduled refresh
FServer settings
»Featured Q&A questions

»Endorsement

You can select the data gateway to be used to connect to your on-premise SAP BW system, and specify a
refresh frequency for the dataset.

4 Scheduled refresh

Keep your data up to date
On

Refresh frequency

| Daily \/|
Time zone

|(UTC-08:00) Pacific Time (US and Canada) \/|
Time

Add another time

~ Send refresh failure notification email to me

Apply Discard

Additional information about configuring scheduled refresh is available at
https://docs.microsoft.com/en-us/power-bi/refresh-scheduled-refresh
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Import Connections: Manual Refresh

If you are listed in the Users tab of the data source configured in the gateway, and the SAP BW server
name, instance and client number match, you will be able to manually refresh the BW dataset. Go to your
Power Bl workspace, select the Datasets tab and choose Refresh from the Actions menu.

i PowerBl DIAD.

@

Home z
- Search content

W Favorites

@ Recent 5 Dashboards Reports Workbooks Datasets Dataflows

B apes NAME ENDORSEMENT ACTIONS

Direct Query Connections

When you interact with a visualization or report with a Direct Query connection to SAP BW, the underlying
source will be queried directly. To enhance performance, Power Bl caches dashboard tiles and refreshes
them periodically. You can change the default frequency for the cache refresh in the settings for your
Direct Query dataset.

Settings for BW DQ Test

This dataset has been configured by

The data gateway is online and your data sources are enline.

Refresh history

»Gateway connection
»Data source credentials
»Parameters

»Query Caching

4 Scheduled cache refresh

There is a direct connection between Power 8l and the database. When you interact with a visualization, queries are sent from Power Bl directly to the
databa and pericdically refreshed. Change the frequency here. (You can always manually
refresh a tile a the tile.)

Learn more sbout Direct Query refresh frequency,

Refresh frequency

1 hour

Email these users when the refresh fails

Please also see https://powerbi.microsoft.com/en-us/blog/announcing-custom-cache-refresh-schedules-
in-the-power-bi-service/ for more information on custom cache refresh schedules in the Power Bl service.
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Support for SAP BW Features

The following table lists all SAP BW features that are not fully supported or will behave
differently when using Power BI.

Feature

Local calculations

Aggregations

Currency formatting

Units of measure

Description

Local calculations defined in a BEX Query will change the numbers as displayed
through tools like Bex Analyzer. However, they are not reflected in the numbers
returned from SAP, through the public MDX interface.

As such, the numbers seen in a Power Bl visual will not necessarily match
those for a corresponding visual in an SAP tool.

For example, when connecting to a query cube from a BEx query that sets the
aggregation to be Cumulated (i.e. running sum), Power Bl would get back the base
numbers, ignoring that setting. An analyst could certainly then apply a running
sum calculation locally in Power BI, but would need to exercise caution in how the
numbers are interpreted if this is not done.

In some cases (particularly when dealing with multiple currencies), the aggregate
numbers returned by the SAP public interface do not match those shown by SAP
tools.

As such, the numbers seen in a Power Bl visual will not necessarily match
those for a corresponding visual in an SAP tool.

For example, totals over different currencies would show as "*" in Bex Analyzer, but
the total would get returned by the SAP public interface, without any information

that such an aggregate number is meaningless. Thus the number (aggregating,
say, $, EUR, and AUD) would get displayed by Power BI.

Any currency formatting (for example, $2,300 or 4000 AUD) is not reflected in
Power BI.

Units of measure (for example, 230 KG) are not reflected in Power BI.
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Feature

Key versus text (short,
medium, long)

Attributes

Multiple hierarchies of a
characteristic

Treatment of ragged
hierarchies

Description

For an SAP BW characteristic like CostCenter, the Navigator will show a single item
Cost Center Level 01. Selecting this item will include the default text for Cost
Center in the field list. In addition, the Key value, Short Name, Medium Name, and
Long Name values are available for selection in the Properties node for the
characteristic (if maintained in SAP BW).

Note that this only applies to Import connectivity mode. For DirectQuery mode,
only the default text will be included in the data set.

The attributes of a characteristic will be available for selection in the Properties for
the characteristic. This only applies to Import connectivity mode. For DirectQuery
mode, attributes will not be available.

In SAP, a characteristic can have multiple hierarchies. Then in tools like BEx
Analyzer, when a characteristic is included in a query, the user can select the
hierarchy to use.

In Power BI, the various hierarchies can be seen in the field list as different
hierarchies on the same dimension. However, selecting multiple levels from two
different hierarchies on the same dimension will result in empty data being
returned by SAP.

SAP BW supports ragged hierarchies, where levels can be missed, e.g.

Continent
Americas
Canada
USA
Not Assigned
Australia

In Power BI, this appears with (Blank) at the missing level:

Continent
Americas
Canada
USA
Not Assigned
(Blank)
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Feature

Scaling factor/reverse
sign

Hierarchies where levels
appear/disappear
dynamically

Default filter

Hidden Key figures

Numeric formatting

Hierarchy versioning

Description

Australia

In SAP, a key figure can have a scaling factor (for example, 1000) defined as a
formatting option, meaning that all display will be scaled by that factor.

It can similarly have a property set that reverses the sign. Use of such a key figure
in Power Bl (in a visual, or as part of a calculation) will result in the unscaled
number being used (and the sign is not reversed). The underlying scaling factor is
not available. In Power Bl visuals, the scale units shown on the axis (K,M,B) can be
controlled as part of the visual formatting.

Initially when connecting to SAP BW, the information on the levels of a hierarchy
will be retrieved, resulting in a set of fields in the field list. This is cached, and if the
set of levels changes, then the set of fields do not change until Refresh is invoked.

This is only possible in Power Bl Desktop. Such Refresh to reflect changes to the
levels cannot be invoked in the Power Bl service after Publish.

A BEX query can include Default Filters, which will be applied automatically by SAP
Bex Analyzer. These are not exposed, and hence the equivalent usage in Power BI
will not apply the same filters by default.

A BEX query can control visibility of Key Figures, and those that are hidden will not
appear in SAP BEx Analyzer. This is not reflected through the public API, and hence
such hidden key figures will still appear in the field list. However, they can then be

hidden within Power BI.

Any numeric formatting (number of decimal positions, decimal point etc.) will not
automatically be reflected in Power Bl. However, it is possible to then control such
formatting within Power BI.

SAP BW allows different versions of a hierarchy to be maintained, for example, the
cost center hierarchy in 2007 versus 2008. Only the latest version will be available
in Power B, as information on versions is not exposed by the public API.
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Feature

Time dependent
hierarchies

Currency conversion

Sort Order

Technical names

End user language
setting

Text Variables

Customer Exit
Variables

Description

When using Power BI, time dependent hierarchies are evaluated at the current
date.

SAP BW supports currency conversion, based on rates held in the cube. Such
capabilities are not exposed by the public API, and are therefore not available in
Power BI.

The sort order (by Text, or by Key) for a characteristic can be defined in SAP. This
sort order is not reflected in Power BI. For example, months might appear as
“April”, “Aug”, and so on.

It is not possible to change this sort order in Power BI.

In the Navigator, the characteristic/measure names (descriptions) and technical
names can both be displayed using the Display Options selector. The field list
contains the characteristic/measure names (descriptions).

The locale used to connect to SAP BW is set as part of the connection details, and
does not reflect the locale of the final report consumer.

SAP BW allows field names to contain placeholders for variables (for example,
"$YEARS Actuals") that would then get replaced by the selected value. For
example, the field appears as "2016 Actuals” in BEx tools, if the year 2016 were
selected for the variable.

The column name in Power Bl will not be changed depending on the variable

value, and therefore would appear as "$YEAR$ Actuals”. However, the column
name can then be changed in Power BI.

Customer Exit variables are not exposed by the public API, and are therefore not
supported by Power BI.
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Performance Considerations

The following table provides a summery list of suggestions to improve performance for data load and

refresh from SAP BW.

Suggestion

Limit characteristics and properties
(attribute) selection

Make use of parameters

Limit number of key figures

Split up very large queries into
multiple, smaller queries

Avoid Virtual Providers
(MultiProviders or InfoSets)

Description

The time it takes to load data from SAP BW into Power Bl increases
with the size of the dataset, i.e. the number of columns and rows in
the flattened result set. To reduce the number of columns, only select
the characteristics and properties in the Navigator that you eventually
want to see in your report or dashboard.

Using filters / parameters contributes to reducing the size of the
result set, thereby significantly improving query runtimes.

Parameters are especially valuable when used with large dimensions,
where there is many members such as customers, materials or
document numbers.

Selecting many key figures from a BEx query/BW model can have a
significant performance impact during query execution, due to the
time being spent on loading metadata for units. Only include the key
figures that you need in Power BI.

For very large queries against InfoCubes or BEx queries it may be
beneficial to split up the query. For example, one query might be
getting the key figures, while another query (or several other queries)
is getting the characteristics data. You can join the individual query
results in the Power Bl Desktop model.

VirtualProviders are similar to structures without persistent storage.
They are useful in many scenarios, but can show slower query
performance because they represent an additional layer on top of
actual data.
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Suggestion

Avoid use of navigation attributes in
BEx query

Use RSRT to monitor and
troubleshoot slow running queries

Avoid Restricted Key Figures and
Calculated Key Figures

Consider using incremental refresh
to improve performance

Description

A query with a navigation attribute has to run an additional join,
compared with a query with the same object as a characteristic in
order to arrive at the values.

You SAP Admin can use the Query Monitor in SAP BW (transaction
RSRT) to analyze performance issues with SAP BW queries. Please
review SAP note 1591837 for more information.

Both are computed during query execution and can slow down query
performance.

Power Bl refreshes the complete dataset with each refresh. If you are
working with large volume of data, refreshing full dataset on each
refresh may not be optimal. In this scenario, you can use incremental
refresh, so you are refreshing only a subset of data. Following link has
details -

https://docs.microsoft.com/en-us/power-bi/service-premium-
incremental-refresh

57


https://docs.microsoft.com/en-us/power-bi/service-premium-incremental-refresh
https://docs.microsoft.com/en-us/power-bi/service-premium-incremental-refresh

Enabling Tracing to debug

While working with SAP BW connector, you might get MDX errors. This is the error that is bubbled from
SAP BW and sometimes it is hard to make sense of these errors. In this scenario, you might want to enable
trace and work through the error. Here is how to do this.

e Create an environment variable PBI_EnableSapBwTracing and set it to true.

e Open Power Bl Desktop file and navigate to File -> Options and Settings -> Options -> Diagnostics.
e Select Open crash dump/traces folder.

e This opens the trace folder.

e Now refresh the report or create a new query.

e Notice trace files are created with the MDX query. Open this file and copy the MDX statement.

e Open SAP GUI use tcode MDXTEST.

e Paste the MDX statement and execute it. You will get more details and work through the issue.

Single Sign-On Configuration

Single Sign-On can be enabled by configuring your SAP BW system with SNC (Secure Network
Communication). The primary purpose of SNC is to secure connections between the NetWeaver ABAP
application server and external applications, including SAP GUI. SNC provides an interface for external
security products which can used to enable Single Sign-On.

For more detailed information please see Secure Network Communication.

The requirements and steps for configuring Single Sign-On (SSO) between an SAP BW system and Power
Bl are described here.

Requirements
The following requirements must be met to configure SSO between your SAP BW system and Power Bl

e Active Directory is required in your landscape

SAP BW Configuration

Please refer to this SAP blog and follow the steps in the video: https://blogs.sap.com/2017/07/27/sap-
single-sign-on-authenticate-with-kerberosspnego/

1. Run the SNCWIZARD / SPNEGO configuration wizards
As of NetWeaver ABAP version 7.31 or higher, use the configuration wizards (transactions
SNCWIZARD and SPNEGO) in your SAP system to configure SSO.

For earlier versions of NetWeaver ABAP, or if you don’t have access to the configuration wizards, you
can configure SSO manually:
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Create a new service user in AD, representing the NetWeaver ABAP system
Use SETSPN to set the Service Principal Name (SPN)

Make sure that your SPN matches your User Principal Name (UPN).

You should use YourServiceUser@DOMAIN for the UPN, and SAP/YourServiceUser as the SPN.
Note the case sensitivity. For additional information see:
https://wiki.scn.sap.com/wiki/display/Security/SNC+Client+Encryption

Install CommonCryptoLib on your SAP BW server

If you are on NetWeaver ABAP kernel 7.20 PL88 or higher, it is highly recommended that you use
CommonCryptolib 8.5.

Please read the following note for lower kernel versions:
https://launchpad.support.sap.com/#/notes/0001848999

You can download CommonCryptoLib from the SAP Service Marketplace (search for
"CommonCryptolLib" in the Downloads section).

Rename the file to SAPCRYPTOLIB.SAR and unzip the .SAR file in a convenient location using the
following SAPCAR command (make sure you are in the same directory as the SAPCAR tool):

sapcar -xvf SAPCRYPTOLIB.SAR

Specify your SECUDIR directory
Your SECUDIR directory is the directory where the CommonCryptolib license ticket file lives, as
well as where all your generated PSE files will go.

To set a directory as your SECUDIR directory, create a new environment variable called SECUDIR
and point it to a directory for example \usr\sap\<SID>\DVEBMGSO00\sec.

Set the profile parameters in your SAP BW instance

Connect to your SAP BW instance via SAP GUI and execute transaction RZ10.

Create new profile parameters as follows:

snc/gssapi_lib = <path to directory where you extracted CommonCryptolLib>\sapcrypto.dll
snc/identity/as = p:CN=YourServiceUser@ DOMAIN

Example:
p:CN=KerberosABC@MYDOMAIN (this is case sensitive!)

Restart the SAP BW instance

Use the SAP Management Console to restart the BW instance and enable the profile parameter
settings.

More information on profile parameter settings can be found here:

https://help.sap.com/saphelp nw70ehp1/helpdata/en/e6/56f466e99a11d1a5b00000e835363f/fra
meset.htm

Create the Kerberos Keytab

Change directory to where you extracted the .SAR file for CommonCryptolLib earlier and run the
following command:

sapgenpse keytab -p SAPSNCSKERB.pse -x <PSE_password> -X <service_user_password> -a
<service_user_UPN>
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10.

11.

Example:
sapgenpse keytab -p SAPSNCSKERB.pse -x 12345 -X KerberosABCPassword -a
KerberosABC@MYDOMAIN

Be sure to use the service user's password for the -X parameter, otherwise you will not be able to
authenticate later.

Your new PSE file should show up in the SECUDIR directory as SAPSNCSKERB.pse.
More information about generating the Kerberos keytab can be found here:
https://help.sap.com/viewer/bce2e80c873a4003a6d446e1f370696d/3.0/en-
US/e49be955aea4461484cebelbe1c8cb01.html

Create the SAP Cryptolib PSE file

After running the previous command, it should produce a warning stating that the SAP Cryptolib
PSE file is missing.

To create the file, sign in to your BW instance via SAPGUI and go to transaction STRUST. Right-
click SNC SAPCryptolib, then select Create. Use the default settings.

Your new PSE file should show up in the SECUDIR directory as SAPSNCS.pse.

More information about creating the PSE can be found here:
https://help.sap.com/saphelp nw70ehpi1/helpdata/en/e6/56f466e99a11d1a5b00000e835363f/fra
meset

Create the SSO credentials
Run the following comand:

sapgenpse seclogin -p <path>\SAPSNCSKERB.pse -x <PIN> -O <system_user>

Example:

sapgenpse seclogin -p /usr/sap/abc/dvebmgS00/sec/SAPSNCSKERB.pse -x 12345 -O
SAPServiceABC

The system user is the user specified in Services.msc for your SAP instance. Usually, this is
SAPService<SID> for Windows and <SID>adm for UNIX.

The credentials created will be stored in a file called cred_v2.

More information on the system user can be found here:
https://help.sap.com/saphelp nw70ehp1/helpdata/en/81/be593bd0714b58e10000000a11402f/co

ntent.htm

More information about creating the SSO credentials can be found here:
https://help.sap.com/viewer/bce2e80c873a4003a6d446e1f370696d/3.0/en-
US/e49be955aead461484cebelObe1c8cb01

Set the profile parameters in your SAP BW instance

Connect to your SAP BW instance via SAP GUI and execute transaction RZ10.
Create new profile parameters as follows:
snc/enable = 1
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12. Restart the SAP BW instance

Use the SAP Management Console to restart the BW instance and enable the profile parameter
settings.

User Mapping

1.
2.
3.

Sign in to your BW instance again via SAPGUI and go to transaction SUO1.

Enter your SAP user (or the user that you want to map for SSO) in the name field and select Edit.

Select the SNC tab and specify the user's SNC name. It should follow this format:
p:CN=USERPRINCIPALNAME@DOMAIN

Note: This is case sensitive!

Secure Login Client

SNC communication will not work unless the external security product is installed on both the client
(Power Bl Desktop) and server. Clients that install Secure Login Client will have CommonCryptolLib
installed for them and all of the environment variables will be preconfigured as well.

The installation package is named SAPSetupSCL.EXE and can be obtained from the SAP Service Marketplace
(requires SAP customer credentials).

For further information please see Secure Login.

Configuring SAP GUI for SNC Communications

You can verify the successful configuration of SSO with SAPGUI.

1.
2.
3.

Open the SAP Logon tool on your desktlop and right-click the connection to your BW instance.
Select Properties and switch to the Network tab.
Click the checkbox for Activate Secure Network Communication and specify the SNC Name.

This should be in the format:
p:CN=ServicePrincipalName@domain
Example:
p:CN=SAP/KerberosABC@mydomain

Click OK and try connecting. If everything was configured correctly, you should be signed in
without being prompted to enter a password.
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